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ArcGIS Data Appliance: Esri Vector Basemaps

Introduction to ArcGIS Data Appliance: Esri Vector
Basemaps

Esri Vector Basemaps provides detailed maps from industry-leading data providers that you can use with your
ArcGIS and web applications. Vector tiles enable dynamic cartography and provide the flexibility to create your own

basemap style. The vector basemaps are available as tile layers that can be added to existing maps as either a
basemap or an overlay layer.

Esri Vector Basemaps provides a content solution that works with ArcGIS Enterprise. It is included (shipped
separately) with ArcGIS Data Appliance 2024 with World Standard, World Advanced, North America Standard, and
North America Advanced product options. It can also be licensed as a stand-alone option.

I Note:
This feature is not included with the World Basic product option.

The Esri Vector Basemaps help includes the following topics:
* Esri Vector Basemaps content

« What's new

« Directory of map styles

+ System requirements

* Set up Esri Vector Basemaps

« Information on how to use Esri Vector Basemaps

» Methods to customize and localize Esri Vector Basemap styles

« Reference information including FAQs, Troubleshooting, and Support

Copyright © 1995-2024 Esri. All rights reserved. 4
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Esri Vector Basemaps content

Esri Vector Basemaps is delivered on a USB flash drive loaded with two vector tile packages, styles, and style
publishing toolboxes (.tbx file).

I Note:
Esri Vector Basemaps ships separately.

This version includes the following:

« Installation vector tile packages that you upload to your ArcGIS Enterprise portal using ArcGIS Pro and publish as
a hosted vector tile service on your hosting server:
= Esri_Vector_Basemap_DA2024_Install.vtpk—A vector tile package for customers who want to use Web

Mercator Auxiliary Sphere (WMA).
= Esri_Vector_Basemap_GCS_DA2024_Install.vtpk—A vector tile package for customers who want to use
Esri Vector Basemaps in WGS84 Geographic (GCS). This . vtpk file uses the WGS84 Geographic, version 2 tiling
scheme.
« Map styles (for each projection) that you publish as vector tile layers to your Enterprise portal to use in your maps

and apps or to customize. These styles require resources included in the VectorBasemapStyles folder for
publishing.

« Vector Style publishing tools for managing vector basemap tile layers (map styles) in your Enterprise portal:
= VectorStylePublisher.tbx—This toolbox is used to create vector basemap tile layers.

= VectorStyleUpdater.tbx—This toolbox is used to update existing vector basemap tile layers.

» Map style text files to help you with map style updates:
= DA2024_WMA_StyleUpdater_template.csv—This file manages WMA styles.

= DA2024_GCS_StyleUpdater_template.csv—This file manages GCS styles.

» A documentation file (data_appliance_esri_vector_basemaps.pdf) that includes instructions for getting

started, set up, using Esri Vector Basemaps, and more.

I Note:
Do not use the Esri_Vector_Basemap_DA2024 Install or Esri_Vector_Basemap_GCS_DA2024 Install vector

tile packages for anything other than publishing the tile layer (hosted). Once you publish the tile layer to your
Enterprise portal, do not share the .vtpk files publicly (Everyone), as distribution of these items outside of your

organization is not permitted.

Copyright © 1995-2024 Esri. All rights reserved. 5
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What's new

This update of ArcGIS Data Appliance: Esri Vector Basemaps contains two updated vector tile packages (. vtpk files)
used to publish as hosted vector tile services in an ArcGIS Enterprise portal. One is in the Web Mercator Auxiliary
Sphere (WMA) projection and the other is in the WGS84/GCS (GCS) tiling scheme. Map styles can be published as
vector tile layers for each option.

These vector tile packages contain updated global data from a variety of sources including commercial,
authoritative agencies and open-source providers, as well as local authoritative data from the Esri Community Maps
Program.

An additional six languages are supported within each Esri Vector Basemap vector tile package, bringing the total to
40 supported languages. The new languages are Bosnian (bs), Bulgarian (bg), Catalan (ca), Croatian (hr), Hungarian
(hu), and Indonesian (id).

There are four new vector tile layers (map styles). All the Esri Vector Basemaps vector tile layers include a data
source change. Existing users of the vector basemaps in ArcGIS Data Appliance can update the hosted tile layer and
the 51 style items from ArcGIS Data Appliance 2023. The VectorStyleUpdater toolbox uses a template of existing
item IDs and can be run in ArcGIS Pro.

New users can publish any or all of the full set of 55 styles.

Copyright © 1995-2024 Esri. All rights reserved. 6
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Directory of map styles

ArcGIS Data Appliance 2024: Esri Vector Basemaps includes the following 55 vector tile layers. The styles can be
published in Web Mercator Auxiliary Sphere (WMA) projection or WGS84/GCS (GCS) tiling scheme.

Layer name and

thumbnail Style folder name
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Description

The Charted Territory vector tile layer
provides a detailed basemap featuring a
geopolitical style reminiscent of a printed
atlas plate or a school classroom wall map.
This layer is designed for use with the World
Hillshade basemap.

The Colored Pencil vector tile layer is
presented in the style of hand-drawn, colored
pencil cartography.

The Community vector tile layer provides a
detailed basemap featuring strong colors to
emphasize large-scale features.

The Dark Gray Canvas vector tile layer
provides a detailed basemap of the world
featuring a dark neutral background style
with minimal colors, labels, and features.

The Dark Gray Canvas (Community Maps)
vector tile layer provides a detailed basemap
featuring a dark neutral background style
with minimal colors, labels, and features with
select roads provided by community
contributors.
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Layer name and

thumbnail Style folder name
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Description

The Dark Gray Canvas Base vector tile layer
provides a detailed basemap of the world
featuring a dark neutral background style
with minimal colors, labels, and features. This
layer is designed for use with the Dark Gray
Canvas Reference layer.

The Dark Gray Canvas Reference vector tile
layer provides a city reference overlay of the
world designed for use over a dark neutral
background style with minimal colors, labels,
and features. This layer is designed for use
with the Dark Gray Canvas Base layer.

The Dark Gray Canvas Reference (Local
Language) vector tile layer provides a
detailed reference label layer. Labels are in
local languages at large scale. This layer is
designed for use with the Dark Gray Canvas
Base layer.

The Enhanced Contrast Base vector tile layer
aims to meet the standards for Web Content
Accessibility Guidelines (WCAG) and U.S.
Government Section 508 compliance. It
includes land cover, water bodies, and
transportation linework. It is designed for use
with the Enhanced Contrast Reference layer.

The Enhanced Contrast Dark Base vector tile
layer aims to meet the standards for WCAG
and U.S. Government Section 508
compliance. It includes land cover, water
bodies, and transportation linework. It is
designed for use with the Enhanced Contrast
Dark Reference layer.
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AT TR BT Style folder name

thumbnail
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Description

The Enhanced Contrast Dark Reference vector
tile layer aims to meet the standards for
WCAG and U.S. Government Section 508
compliance. It includes administrative
boundaries and map labels. It is designed for
use with the Enhanced Contrast Dark Base
layer.

The Enhanced Contrast Reference vector tile
layer aims to meet the standards for WCAG
and U.S. Government Section 508
compliance. It includes administrative
boundaries and map labels. It is designed for
use with the Enhanced Contrast Base layer.

The Human Geography Base vector tile layer
provides a detailed vector basemap of the
world symbolizing the land with a light gray,
neutral background style.

The Human Geography Dark Base vector tile
layer provides a simple vector basemap of
the world symbolizing the land with a very
dark gray, neutral background style.

The Human Geography Dark Detail vector tile
layer provides a detailed basemap with a dark
monochromatic style and content adjusted to
support human geography information. This
layer is a detailed reference layer that
includes administrative boundaries, roads,
and highways.
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AT TR BT Style folder name
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Description

The Human Geography Dark Label vector tile
layer provides a detailed basemap with a dark
monochromatic style and content adjusted to
support human geography information. The
map includes labels for highways, major
roads, minor roads, water features, cities,
landmarks, and administrative boundaries.

The Human Geography Detail vector tile layer
provides a detailed basemap with a
monochromatic style and content adjusted to
support human geography information.

The Human Geography Label vector tile layer
provides a detailed vector basemap for world
labels designed to draw attention to the
thematic content.

The Hybrid Reference Layer vector tile layer
provides a detailed reference layer of the
world designed to be overlaid on imagery.

The Hybrid Reference Layer (Community
Maps) vector tile layer provides a detailed
reference layer of the world designed to be
overlaid on imagery with select roads
provided by community contributors.
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Layer name and

thumbnail Style folder name
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Description

The Hybrid Reference Layer (Local Language)
vector tile layer provides a detailed reference
layer, including transportation and labels of
the world. Labels are in local languages at
large scale. This layer is designed for use with
the World Imagery basemap.

The Light Gray Canvas vector tile layer
provides a detailed vector basemap of the
world symbolized with a light gray, neutral
background style with minimal colors, labels,
and features that is designed to draw
attention to the thematic content.

The Light Gray Canvas (Community Maps)
vector tile layer provides a detailed basemap
featuring a light neutral background style
with minimal colors, labels, and features.
Select roads are provided by community
contributors.

The Light Gray Canvas Base vector tile layer
provides a detailed basemap of the world
featuring a light neutral background style
with minimal colors, labels, and features. This
layer is designed for use with the Light Gray
Canvas Reference layer.

The Light Gray Canvas Reference vector tile
layer provides a detailed reference overlay of
the world featuring a light neutral
background style with minimal colors, labels,
and features. This layer is designed for use
with the Light Gray Canvas Base layer.

11



ArcGIS Data Appliance: Esri Vector Basemaps

Layer name and

thumbnail Style folder name
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Description

The Light Gray Canvas Reference (Local
Language) vector tile layer provides a
detailed reference label layer. Labels are in
local languages at large scale. This layer is
designed for use with the Light Gray Canvas
Base layer.

The Mid-Century vector tile layer provides a
customized vector layer of the world
symbolized with a unique mid-century-styled
map. It takes its inspiration from the art and
advertising of the 1950s with unique fonts.
The symbols for cities and capitals have an
atomic slant to them.

The Modern Antique vector tile layer provides
a customized vector layer of the world
symbolized with a unique antique-styled map
and a modern flair—including the benefit of
multiscale mapping.

The National Geographic Style vector tile
layer provides a detailed basemap featuring
boundary ribbons and other map content.
This layer is designed for use with the World
Hillshade relief basemap for added context.

The National Geographic Style (Local
Language) vector tile layer provides a
detailed basemap featuring boundary ribbons
and other map content. This layer is designed
for use with the World Hillshade relief
basemap for added context. Labels are in
local languages at large scale.
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AT TR BT Style folder name
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Description

The Newspaper vector tile layer provides a
customized vector layer of the world
symbolized with a unique newspaper-styled
map. It has a black and white appearance
with select features highlighted in red. Many
of the area fills have halftone patterns
commonly found in traditional newspaper
printing.

The Nova vector tile layer provides a detailed
basemap of the world featuring a dark
background with glowing blue symbology
inspired by the ArcGIS.com splash screen. The
Nova vector tile layer emulates this color
scheme with a grid pattern across the ocean
and stripes or square stippled patterns for
land-use features visible at larger scales.

The Outline vector tile layer provides a
detailed basemap of the world featuring a
simple black and white outline.

The World Navigation Map vector tile layer
provides a detailed basemap of the world
featuring a custom navigation map style.

The World Navigation Map (Community
Maps) vector tile layer provides a detailed
basemap of the world featuring a custom
navigation map style with select roads
provided by community contributors.

The World Navigation Map (Local Language)
vector tile layer provides a detailed basemap
of the world featuring a custom navigation
map style. Labels are in local languages at
large scale.
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Layer name and

thumbnail Style folder name

World Navigation Map
(Dark Mode)
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navigationdarklocallanguage

Description

The World Navigation Map (Dark Mode)
vector tile layer provides a detailed basemap
featuring a dark navigation map style.

The World Navigation Map (Dark Mode -
Community Maps) vector tile layer provides a
detailed basemap featuring a dark navigation
map style with select roads provided by
community contributors.

The World Navigation Map (Dark Mode -
Local Language) vector tile layer provides a
detailed basemap featuring a dark navigation
map style. Labels are in local languages at
large scale.

The World Ocean Reference vector tile layer
provides a detailed basemap featuring a
custom ocean style. This layer is designed for
use with the World Ocean Base raster layer.

The World Street Map vector tile layer
provides a detailed basemap of the world
featuring a classic Esri street map style.
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Layer name and
thumbnail

World Street Map
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Copyright © 1995-2024 Esri. All rights reserved.

streetmaplocallanguage

streetmapnightcommunity

streetmapnightlocallanguage

Description

The World Street Map (Community Maps)
vector tile layer provides a detailed basemap
of the world featuring a classic Esri street map
style with select roads provided by
community contributors.

The World Street Map (Local Language)
vector tile layer provides a detailed basemap
of the world featuring a classic Esri street map
style. Labels are in local languages at large
scale.

The World Street Map (Night) vector tile layer
provides a detailed basemap of the world
featuring a custom nighttime street map
style.

The World Street Map (Night - Community
Map) vector tile layer provides a detailed
basemap of the world featuring a custom
nighttime street map style with select roads
provided by community contributors.

The World Street Map (Night-Local
Language) vector tile layer provides a
detailed basemap of the world featuring a
custom nighttime street map style. Labels are
in local languages at large scale.
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Layer name and
thumbnail
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Description

The World Street Map (with Relief) vector tile
layer provides a detailed basemap of the
world featuring a classic Esri street map style
designed for use with a relief map.

The World Street Map (with Relief -
Community Maps) vector tile layer provides a
detailed basemap of the world featuring a
classic Esri street map style designed for use
with a relief map. Select roads are provided
by community contributors.

The World Terrain Base vector tile layer
displays minimal map content: water and land
fill, water lines, and roads. This layer is
designed for use as a base layer with the
World Terrain Reference layer and World
Hillshade basemap.

The World Terrain Reference vector tile layer
displays minimal map content: populated
place-names, administrative areas, and water
labels with boundary lines. This layer is
designed for use as a reference overlay with
the World Terrain Base layer and the World
Hillshade basemap.

The World Terrain Reference (Local
Language) vector tile layer provides a
detailed reference layer of the world. Labels
are in local languages at large scale. This layer
is designed for use with the World Terrain
Base layer and the World Hillshade basemap.

16



ArcGIS Data Appliance: Esri Vector Basemaps

Layer name and
thumbnail
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Description

The World Terrain with Labels vector tile layer

provides a detailed basemap of the world
symbolized with populated places,
administrative areas, boundary lines, and
roads. The minimal features and styling are
designed to draw attention to the thematic
content.

The World Terrain with Labels (Community
Maps) vector tile layer provides a detailed
basemap of the world symbolized with
populated places, administrative areas,
boundary lines, and roads. The minimal
features and styling are designed to draw
attention to the thematic content. Select
roads are provided by community
contributors.

The World Topographic Map vector tile layer

provides a detailed basemap of the world

featuring a classic Esri topographic map style

designed for use with a relief map.

The World Topographic Map (Local
Language) vector tile layer provides a
detailed basemap of the world featuring a
classic Esri topographic map style. Labels are
in local languages at large scale. This layer is
designed for use with the World Hillshade
basemap.
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Frequently asked questions

Listed below are frequently asked questions and answers regarding ArcGIS Data Appliance: Esri Vector Basemaps.
» How does ArcGIS Data Appliance: Esri Vector Basemaps work?

* How do | set up Esri Vector Basemaps?

* Where does the data come from?

+ Does Esri Vector Basemaps include imagery?

» What services are available?

+ Are there any use restrictions when using Esri Vector Basemaps?

» Where can | find more information about editing custom styles?

» Where can | find more information about using basemaps in my Portal for ArcGIS Map Viewer Classic?

» What if | need further assistance?

How does ArcGIS Data Appliance: Esri Vector Basemaps work?

ArcGIS Data Appliance: Esri Vector Basemaps is published as a hosted vector tile service from your ArcGIS Enterprise
portal along with several dozen map styles that you can share, use, and customize within your organization. For
more information about vector basemaps and the differences between raster and vector tile layers, see Tile layers in
the Portal for ArcGIS help.

How do | set up Esri Vector Basemaps?

Refer to the instructional video and help documentation in the Esri Vector Basemaps Additional resources section of
the ArcGIS Data Appliance 2024 website to learn how to set up and use Esri Vector Basemaps.

Where does the data come from?

These vector tile packages contain updated global data from a variety of sources including commercial,
authoritative agencies and open-source providers, as well as local authoritative data from the Esri Community Maps
Program.

Does Esri Vector Basemaps include imagery?

No. Esri Vector Basemaps does not include raster basemaps or imagery.

What services are available?

Esri Vector Basemaps only requires one service published as a hosted vector tile layer from your portal. Other maps
are included as map styles that you publish to your portal as tile layers. See Directory of map styles for the vector
tile layers included with Esri Vector Basemaps.

Copyright © 1995-2024 Esri. All rights reserved. 18
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Are there any use restrictions when using Esri Vector Basemaps?

The data is provided by multiple third-party data vendors under license to Esri for inclusion in ArcGIS Data
Appliance for use with Esri software. Redistribution rights are granted by Esri and the data vendor for hard-copy
renditions or static, electronic map images (for example, .gif and . jpeg files) that are plotted, printed, or publicly
displayed with proper metadata and source or copyright attribution to the respective data vendor or vendors. For
copyright and attribution information, see Credits for a specific map published to your portal.

Where can | find more information about editing custom styles?

View the New ways of customizing Esri Vector Basemaps article on the ArcGIS Blog website for more information
about editing custom styles.

Where can | find more information about using basemaps in my Portal for ArcGIS Map Viewer Classic?

See Customize basemaps and Choose a basemap (Map Viewer Classic) in the Portal for ArcGIS help for more
information about using basemaps in your Portal for ArcGIS Map Viewer Classic.

What if | need further assistance?

For all questions, feedback, and troubleshooting, and to report issues, contact Esri Support.

Copyright © 1995-2024 Esri. All rights reserved. 19
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System requirements
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Esri Vector Basemaps system requirements for ArcGIS
Data Appliance 2024

The following software components and prerequisites are required before you deploy Esri Vector Basemaps for
ArcGIS Data Appliance 2024 :
+ ArcGlIS Pro Basic, Standard, or Advanced 3.2 or later

« An ArcGIS Enterprise 10.9.1, 11.0, 11.1, or 11.2 deployment meeting the base ArcGIS Enterprise deployment
specifications

I Note:
Authentication exclusions—The Linux public key infrastructure (PKI) configuration is not supported.

Before you start
Before you begin your deployment, do the following:

1. Check with your portal administrator to verify or request the following:
« A Portal for ArcGIS account with the Publisher or Administrative role enabled.

« A named user license enabled for ArcGIS Pro Standard or Advanced.

« The following minimum available space per .vtpk file on your Enterprise 10.9.1, 11.0, 11.1, or 11.2 portal
content directory:

Minimum . . . .
total !-Izs:ll.ng server's Ho.;tmg. server's
Vector tile package (.vtpk) file available Jo il 'L‘idory cac.lebllrectory
space available space  available space
required required required
fvilrl;;;;/ector‘_Basemap_DA2024_Install.vtpk 94 GB 47 GB 47 GB
fvflzls_s\ge)ctor_Basemap_GCS_DA2024_Install.vtpk 94 GB 47 GB 47 GB

2. Check with your ArcGIS Server administrator to verify or request the following:
+ The following minimum available space per .vtpk file on your ArcGIS Server machine:

Minimum total available space required

e We prdere gy il (Enterprise 10.9.1, 11.0, 11.1, 11.2)

Esri_Vector_Basemap_DA2024 Install.vtpk

(WMA) 94 GB
Esri_Vector_Basemap_GCS_DA2024_Install.vtpk 94 GB
(WGS84)

+ Enough pooling time for your ArcGIS Server. Successfully publishing a large .vtpk file as a hosted vector tile

service requires more time for the web client to communicate with ArcGIS Server. Check with your ArcGIS
Server administrator to confirm that the The maximum time a client can use a service option is set to
21,600 seconds.

Copyright © 1995-2024 Esri. All rights reserved.
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Complete the following steps for ArcGIS Server 10.9.1, 11.0, 11.1, or 11.2:

» Open a new browser and access ArcGIS Server Manager, for example, https://PORTALNAME/server/
manager, and sign in.

« Click Site (root) > System > PublishingTools.

« Click Pooling, and under Specify Service Timeouts, change the value for The maximum time a client
can use a service from 3,600 seconds (1 hour) to 21600 seconds (6 hours).

@ Ar<is server Monager =R -
Manage Services OGC Services KML Netwaork Links Sharing
Editing: Site (root) > System > PublishingToals Help | Save and Restart | Cance

« Click Save and Restart.
« Sign out of ArcGIS Server Manager.

ArcGIS Data Appliance 2024: Esri Vector Basemaps is delivered on a USB flash drive loaded with vector tiles,
styles, and style publishing tools. Copy all contents of the USB flash drive to your local computer.

3. Copy all contents of the USB flash drive to your local computer. Ensure your local computer has enough storage
space to download the files from the flash drive. The additional storage space required for the local staging path

is equal to the size of the .vtpk file being shared to your portal.
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Setup
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Set up ArcGlIS Data Appliance: Esri Vector Basemaps

The instructions to set up ArcGIS Data Appliance: Esri Vector Basemaps depend on whether you are a new or an
existing user. See the appropriate instructions as follows:
* New user

+ Existing user

When you finish setting up ArcGIS Data Appliance: Esri Vector Basemaps, your vector basemaps are ready to use.
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Set up Esri Vector Basemaps (new user)

For information about what's included with Esri Vector Basemaps, see Esri Vector Basemaps content.

I Note:
Before you proceed, review the system requirements to confirm that you can deploy Esri Vector Basemaps on your

system.

Once you confirm that the system requirements are met, the workflow to set up Esri Vector Basemaps is as follows:
1. Upload the package to your ArcGIS Enterprise portal

2. Publish the hosted tile layer (service)

3. Publish tile layers (map styles)

4. Share tile layers (map styles)

I Note:
Esri Vector Basemaps includes two vector tile packages (.vtpk) on the flash drive. The

Esri_Vector_Basemap_DA2024 Install.vtpk file is in the Web Mercator Auxiliary Sphere (WMA) projection. The
Esri_Vector_Basemap_GCS_DA2024 Install.vtpk file is in the WGS84/GCS (GCS) tiling scheme. The following

steps reflect the sharing process of the WMA vector tile package. To share the GCS package, you must provide the
correct .vtpk file name for the input package as well as take the GCS naming into consideration when publishing

the hosted tile layer. The Esri Vector Basemaps styles in the GCS directory already take the GCS naming into account
in the metadata files.

Upload the package to your ArcGIS Enterprise portal
First, you must copy the entire USB flash drive contents to your local computer if you have not already done so.

1. Start ArcGIS Pro, sign in to your ArcGIS Enterprise portal, click the Options button ==+, and click Set As Active
Portal.

Portals

E‘O https://your portal name/portal/

Available : Signed in as

Save As

I Note:

You must sign in and connect to your portal before you proceed. You cannot provide your portal username and
password when using the Share Package tool later in these instructions. The tool obtains your credentials from
ArcGlIS Pro.
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2. Create a project.

3. Click the Analysis tab, and click Tools in the Geoprocessing group.

[~ == - - 3

Home nsert Analysis view
QDB P K EaE L8 H B O

magery Share

History Python ModelBuwilder Environments Tools Ready To Feature Raster Spatial Chip ntersect
Use Tools~  Analysis~ Analysis ~ Jain
Geoprocessing B Portal

The Geoprocessing pane appears.

4. In the Geoprocessing pane, search for Share Package, and select the Share Package (Data Management

Tools) tool from the search results.

Geoprocessing X
€ |SharEPackagE X - 'b'
A
Share Package D=tz liznzgement Took
Shares a package by uploading to ArcGIS Online or ArcGIS
Enterprise.

-

Create Mobile Scene Package (Cztz Manzgement Tooks
Creates a mobile scene package file (.mspk) from ene or more
scenes for use across the ArcGlS platform.

-

Package Map (Cztz Management Tocks
Packages a map and all referenced data sources to create a single
compressed .mpkx file,

-

5. On the Share Package dialog box, do the following:
a. For Input Package, provide the path to the vector tile package, for example, C:\Projects\

Esri_Vector_Basemaps_2024\VTPK\Esri_Vector_Basemap_DA2024 Install.vtpk.
b. For Summary, type Esri Vector Basemap for Data Appliance 2024.

c. For Tags, type 2024, v2.
A\ Caution:

Do not change the Credits parameter value and do not check the Everybody or Within Organization check
boxes for sharing.
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Geoprocessing * 3 X
® Share Package ®
Parameters Environments

Input Package
C\Projects\Esri_Vector_Basemaps_2024\VTPK\Esri_Vector_Basemap_DA2024 Install.vtpk
Summary

Esri Vector Basemap for Data Appliance 2024

Tags
2024, v2

Credits

6. Click Run.

It will take approximately 30 to 120 minutes to upload the package to your portal. A Share Package Uploaded
Successfully message appears in the Share Package window once the upload is complete.

7. Through your portal, confirm that the . vtpk file uploaded successfully.

a. Open a web browser and sign in to your portal.
The Esri_Vector_Basemap_DA2024 _Install tile package is located in the root folder.

b. Confirm that the Size value of the tile package matches the size for your vector tile package and Enterprise
version in the following table and Shared with indicates that the item is not shared.

Vector tile package .vtpk file Enterprise version Size
10.9.1 44,616 MB
Esri_Vector_Basemap_DA2024 Install.vtpk (WMA) 11.0 46,784 MB
11.1and 11.2 44,616.449 MB
10.9.1 44,286 MB
Esri_Vector_Basemap_GCS_DA2024 Install.vtpk (WGS84) 11.0 46,438 MB
11.1and 11.2 44,286.461 MB

Your item will look similar to the following when uploading Esri_Vector_Basemap_DA2024_Install.vtpk

(WMA) in Enterprise 11.2:
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Esri_Vector_Basernap_DAZ024_Insall »

esri

DATA APPLIANCE 2024

= Eerl_Mector_Basemap DAZ024 Install This vecnos o . [ g o b AscGIS Enterprias ——

= Ewi_Vector_Basemap_vi

mprtant Use Requinements: T

I Note:
If the size is not correct, delete the item and upload the Esri_Vector_Basemap_DA2024_Install tile package again.
You may want to discuss the problem with your portal administrator.

For the Esri_Vector_Basemap_GCS_DA2024_Install tile package, if the Size is not correct, delete the item and
upload it again.

See the Troubleshooting Esri Vector Basemaps topic for more information.

Publish the hosted tile layer (service)
Now you'll publish the Esri Vector Basemap hosted tile layer service from your portal.

1. Sign in to your ArcGIS Enterprise portal.

I Note:
Your account must have publishing credentials.

2. In My Content, go to the item page for the vector tile package
(Esri_Vector_Basemap_DA2024_Install.vtpk) you uploaded to your portal.

3. Click Publish, change the title to Esri_Vector_Basemap_v2, and click Publish again.
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Publish

Publish this item as a hosted layer.

Title:

Esri_Vector_Basemap_WV2

Tags:
2024 X||v2 X
Publish Cance
I Note:

For the GCS tile package (Esri_Vector_Basemap_GCS_DA2024_Install.vtpk), change the title to

Esri_Vector_Basemap_GCS_v2.

I Note:
It will take 30 to 120 minutes to create the hosted layer, depending on your system configuration.

The Esri_Vector_Basemap_v2 hosted tile layer is created.

[ Title
(0 B Esri_Vector_Basemap_v2 Tile Layer (hosted) 7]
] &8 Esri_Vector_Basemap_DA2024_Insta Vector Tile Package &

Publish tile layers (map styles)
You'll publish the map styles next.
The VectorStylePublisher geoprocessing toolbox can be run in ArcGIS Pro. This toolbox publishes 55 tile layers to

your portal.
These instructions assume that the toolbox and VectorBasemapStyles folder are on your local computer.

“ s » ThisPC » 0SDisk (C) » Projects » Esn_Vector_Basemaps_2024 =
Program Files (x85) i Name ¥ Type
b Projects Toclbox File folder
oo Esri_Vector_Basemaps_2024 VectorBasemapStyles File falder
Teelbex VTPK File folder

VectorBasemapStyles () data_appliance_esri_vector_basemaps

VIPK
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I Note:
You must have a portal account assigned to the default publisher or administrator role, or your account must be
assigned to a custom role that has privileges to create content and publish hosted tile layers.

1. Start ArcGIS Pro, sign in to your ArcGIS Enterprise portal, click the Options button ---, and click Set As Active
Portal.

2. Create a project.

3. Click the View tab, click Catalog View in the Windows group, right-click Toolboxes, and click Add Toolbox.

B = g - -
Catalog nsert Analysis View Imagery Share
I:rr '— j:| > | — v [/] Show Details Panel [iE] Display Type -
By B ] L L o
v rl . | Search My Organization__| More Detail
Reset Catalog Catalog Contents Python Tasks Reviewer Workflow )
Panes~ Pane View Rules Manager= || Show Pop-ups
Windows Options
NEALUTN = cociog x |
O —l » Project »
Aap
E a Add Toolbox [}
Ed  Mew Toolbox Add Foolbox

Bl Mew Python Toolbox

an existing t

At :
Databases saves a reference to the toolbox.

the project. The project

4. Browse to the location on your local computer where you copied the contents of the USB flash drive, click
VectorStylePublisher.tbx, and click OK.

Add Teolbox &
€ O ]“ OSDisk (C:) » Projects » Esri_Vector_Basemaps_2024 » Toolbox » + Q|| 1= | Search 2
Organize = Newltem ~ Hi
4 Esri_Vector_Basemaps_2024 Narne ype
Toolbax Bla VectorStylaPublishertbx b Toolbex
VectorBasemapStyles B VectorStyleUpdater.thx Toolbex
VTPK
v
o . - »
Name | VectorStylePublicher.tha Torolbooes (Al Types)
1
oK | Cancel |

The VectorStylePublisher toolbox is added to the project.
5. Double-click Toolboxes and double-click VectorStylePublisher.tbx.
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—

I\(_-:I ﬁ‘} |:| ¥ Project » Toolboxes »

MyProject.tbx

Eﬁ[‘ SO

6. Double-click the Vector Style Publisher script.

'C(:—j' 'Ei‘:' D » Project » Toolboxes » VectorStylePublis

— Vector Style Publisher

7. On the Vector Style Publisher dialog box, click the Parameters tab and do the following:

Geoprocessing -1 x
® Vector Style Publisher &)
Parameters Environments ?)

i

Folder containing vector styles

C:\Projects\Esn_Vector_Basemaps_2024\VectorBasemapStyles\ WMA_Styles\WMA_Newlser

Vector Tile Service URL
https:/f<portal_domain>/serverfrast/services/Hosted/Esri_Vector Basemap v2/VectorTileServar

Metadata folder name

metadata
[] Share vector style web layers publicly

» PKI Authorization

» Linux LDAP

a. For Folder containing vector styles, browse to the location of the VectorBasemapStyles folder on your local
computer, for example, C:\Projects\Esri_Vector_Basemaps_2024\VectorBasemapStyles\
WMA_Styles\WMA_NewUser.

b. For Vector Tile Service URL, provide the URL of the Esri Vector Basemap hosted tile layer, for example,
https://portalname.domain.com/server/rest/services/Hosted/Esri_Vector_Basemap_v2/
VectorTileServer.
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I Note:
The vector tile service URL is in the URL section of the Esri_Vector_Basemap_v2 hosted tile layer item page.

Click the Copy button and paste the URL in the Vector Tile Service URL parameter text box.

Esri_Vector_Basemap_v2

t EsriVector Basemap for Data Applance 2024
- T -

o esri
DATA APPLIANCE 2024
WA '
O

Saurces: Ear, TomTom, Garmin, FAC,
NOAA, USGEE, (c) OpendirestMap
contributars, and the GIS User
Community

c. For Metadata folder name, keep the default name metadata.

L Note:
If you are using a portal with PKI authentication, expand PKI Authorization and provide values for the

PKI_Certificated_file_(.pfx) and PKI Private Password parameters.

v PKI Authorization
PK|_Certificated_file_(.pfx)

PKl Private Password

If you are using a portal with Linux LDAP authentication, expand Linux LDAP and provide information for
the Sign In Username and Sign In Password parameters.

v Linux LDAP

Sign In Username

Sign In Password

d. Click Run.

The 55 vector tile layers (map styles) are created in your assigned ArcGIS Enterprise account. You can view the items
in My Content. Fifty-seven items are listed: 55 vector tile layers, the .vtpk file, and the hosted tile layer.
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Share tile layers (map styles)

The items created are private unless you check the Share vector style web layers publicly check box to make
them public.

Geoprocessing > X%

© Vector Style Publisher

(&)

f3)

Parameters Environments
Folder centaining vector styles — - R
| C:\Prc-jects\Esri_‘-fector_Basemaps_2[!24\‘u’ectorBasemapSters\WMA_StyIes\WMA_NewUseri
Wector Tile Service URL
https://«portal_domainz/server/rest/services/Hosted/Esri_Vector Basemap_vZ/VectorTileServer

Metadata folder name
| metadata

are vector style web layers publicly
* PKI Authorization
¥ Linux LDAP

Alternatively, you can select the map items in your portal and change the sharing settings.

Share
Share the itermn(s) with:

Everyane

Authentication

Theze settings will replace the current settings.

No groups available to share to.

oK Cance
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I Note:

Delete protection for all items is applied on publishing the tile layers. To change the protection setting, open the
item and click the Settings tab. Under Delete Protection, uncheck Prevent this item from being accidentally
deleted and click Save.

Dark Gray Canvas Base

Settings

General  Tile Layer

General

Content Status

Discourage the use of this item.

‘ Mark as Deprecated

Delete Protection

@uerl: this itemn frem being accidentally deleted.

Extent

‘ Set Extent

Once you set up Esri Vector Basemaps, you can do the following:
* Use Esri Vector Basemaps
 Customize styles

* Localize styles
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Set up Esri Vector Basemaps (existing user)

Follow the workflows below to update Esri Vector Basemaps in WMA.

I Note:
To use Esri Vector Basemaps in the GCS format, complete the steps using the information for GCS.

For information about what's included with Esri Vector Basemaps, see Esri Vector Basemaps content and What's
new.

You'll use the following workflow to update Esri Vector Basemaps:
1. Upload the package to your ArcGIS Enterprise portal

2. Publish the new hosted tile layer (service)

I Note:
The title of the new hosted tile layer must be different than the title of the existing hosted tile layer (for

example, the name of the new layer is Esri_Vector_Basemap_DA2024_v2).

Replace the existing hosted tile layer (service) with the new hosted tile layer

Update existing tile layers (map styles)

v~ W

Publish new tile layers (map styles)

6. Share tile layers (map styles)
Upload the package to your ArcGIS Enterprise portal

First, you must copy the entire USB flash drive contents to your local computer if you have not already done so.
Review the system requirements to confirm that you can deploy the Esri Vector Basemaps update.

1. Start ArcGIS Pro, sign in to your ArcGIS Enterprise portal, click the Options button -:+, and click Set As Active

Portal.

Portals

E=° httpsi//your portal name/portal/

Awvailable : Signed in as

Save As .
Test Availability

Portals

I Note:

You must sign in and connect to your portal before you proceed. You cannot provide your portal username and

password when using the Share Package tool later in these instructions. The tool obtains your credentials from
ArcGlIS Pro.
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2. Create a project.

3. Click the Analysis tab, and click Tools in the Geoprocessing group.

[~ == - - 3

Home nsert Analysis view
QDB P K EaE L8 H B O

magery Share

History Python ModelBuwilder Environments Tools Ready To Feature Raster Spatial Chip ntersect
Use Tools~  Analysis~ Analysis ~ Jain
Geoprocessing B Portal

The Geoprocessing pane appears.

4. In the Geoprocessing pane, search for Share Package, and select the Share Package (Data Management

Tools) tool from the search results.

Geoprocessing X
€ |SharEPackagE X - 'b'
A
Share Package D=tz liznzgement Took
Shares a package by uploading to ArcGIS Online or ArcGIS
Enterprise.

-

Create Mobile Scene Package (Cztz Manzgement Tooks
Creates a mobile scene package file (.mspk) from ene or more
scenes for use across the ArcGlS platform.

-

Package Map (Cztz Management Tocks
Packages a map and all referenced data sources to create a single
compressed .mpkx file,

-

5. On the Share Package dialog box, do the following:
a. For Input Package, provide the path to the vector tile package, for example, C:\Projects\

Esri_Vector_Basemaps_2024\VTPK\Esri_Vector_Basemap_DA2024 Install.vtpk.
b. For Summary, type Esri Vector Basemap for Data Appliance 2024.

c. For Tags, type 2024, v2.
A\ Caution:

Do not change the Credits parameter value and do not check the Everybody or Within Organization check
boxes for sharing.
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Geoprocessing * 3 X
® Share Package ®
Parameters Environments

Input Package
C\Projects\Esri_Vector_Basemaps_2024\VTPK\Esri_Vector_Basemap_DA2024 Install.vtpk
Summary

Esri Vector Basemap for Data Appliance 2024

Tags
2024, v2

Credits

6. Click Run.

It will take approximately 30 to 120 minutes to upload the package to your portal. A Share Package Uploaded
Successfully message appears in the Share Package window once the upload is complete.

7. Through your portal, confirm that the . vtpk file uploaded successfully.

a. Open a web browser and sign in to your portal.
The Esri_Vector_Basemap_DA2024 _Install tile package is located in the root folder.

b. Confirm that the Size value of the tile package matches the size for your vector tile package and Enterprise
version in the following table and Shared with indicates that the item is not shared.

Vector tile package .vtpk file Enterprise version Size
10.9.1 44,616 MB
Esri_Vector_Basemap_DA2024 Install.vtpk (WMA) 11.0 46,784 MB
11.1and 11.2 44,616.449 MB
10.9.1 44,286 MB
Esri_Vector_Basemap_GCS_DA2024 Install.vtpk (WGS84) 11.0 46,438 MB
11.1and 11.2 44,286.461 MB

Your item will look similar to the following when uploading Esri_Vector_Basemap_DA2024_Install.vtpk

(WMA) in Enterprise 11.2:
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Esri_Vector_Basernap_DAZ024_Insall »

esri

DATA APPLIANCE 2024

= Eerl_Mector_Basemap DAZ024 Install This vecnos o . [ g o b AscGIS Enterprias ——

= Ewi_Vector_Basemap_vi

mprtant Use Requinements: T

I Note:
If the size is not correct, delete the item and upload the Esri_Vector_Basemap_DA2024_Install tile package again.
You may want to discuss the problem with your portal administrator.

For the Esri_Vector_Basemap_GCS_DA2024_Install tile package, if the Size is not correct, delete the item and
upload it again.

See the Troubleshooting Esri Vector Basemaps topic for more information.

Publish the new hosted tile layer (service)
Now you'll publish the Esri Vector Basemap hosted tile layer service from your portal.

1. Sign in to your ArcGIS Enterprise portal.

I Note:
Your account must have publishing credentials.

2. In My Content, go to the item page for the vector tile package
(Esri_Vector_Basemap_DA2024_Install.vtpk) you uploaded to your portal.

3. Click Publish, change the title to Esri_Vector_Basemap_DA2024_v2, and click Publish again.
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Publish X

Publish this item as a hosted dyer.

m
i

sri_Vector_Basemap_DA2024 v2

2024 X|lv2 X

I Note:
For the GCS tile package, use the Esri_Vector_Basemap_GCS_DA2024_Install.vtpk file. Change the title to
Esri_Vector_Basemap_GCS_DA2024_v?2 for the hosted tile layer that gets published.

I Note:
It will take 30 to 120 minutes to create the hosted layer, depending on your system configuration.

The Esri_Vector_Basemap_DA2024_v2 hosted tile layer is created.

Title

Replace the existing hosted tile layer (service) with the new hosted tile layer
(service)

Next, you'll replace the 2023 basemap hosted tile layer (service) with the 2024 hosted tile layer (service).
1. Sign in to your ArcGIS Enterprise portal.

I Note:
Your account must have publishing credentials.

2. In My Content, go to the item page for the Esri_Vector_Basemap_v2 vector tile service.

3. Click Replace Layer.
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esr
DATA APFLIANCE 2021

4. Click Select, and select the new hosted tile layer that you just published, for example,
Esri_Vector_Basemap_DA2024_v2.

B Tile Layer
Esri_Vector_Basemap_DA2024_v2 : ‘L 3

Esri Vector Basemap for Data Appliance 2024 @esn
DATA APPLIANCE 2024

WMA

Updated () View detalls

5. For Archive the current layer as, click the edit button and change the value to
Esri_Vector_Basemap_DA2023_v2 and click Save. Then, scroll to Replace item information and turn it on.

®  Archive the current layer as Esi_Vector_Basemap_DAZ023 u!@

The content of tha current layer is archivied, A new lagper is created ta archive the curment layer. The replacement layer is deleted aferwarnds

« Tha item id and URL of the current layer i retsndd 50 that sppd and styles ,.;2(* /
referancing the leyer continue 16 wark A e -
..
= Tharcorant ol the currant layr is archived o8-8 vew laysr. Q.h ,/ e ~
3 Fa o ~. ~
+ Tha replacemant layer is delated s®er the curment Layer is replaced. - e o
P " 4 P Rislacemart layar e T frckieed

o el for crmating dessnated [apers for anchies v e ~

Use the replacement layer as the archive

The content of the current layer is swapped with the cantant of the replacement layer,

g Castrine Liyae
"

<

* Na new layers ane crested. The item id and URL of both the curnent layer and e -~
ayer ace rotined 5o that apps and styles refonancing the lyers P S, "/_,/"\\
wonk Lats < >
s
» Il fur arviranmenis that de not want 1o crote & designated layer for el L -~
y Replssemant Lot e
archiving P .3/
~. -
<~
Replace item information
Tt will update the iterm infeemation fram the replicement lxyper, including: thumbeail, summary, descripson, and ags

6. Click Next.

7. On the Replace Layer summary, click Replace.
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Replace Layar &) X

Select replacement layer Choose archive option Summary

Esri_Vector_Basemap_v2
8 Tila Layar Bry

Raplecnemen layer

Esri_Vector_Basemap_DA2024 _v2

B Tiks Liyae by

1% Ler_Vector_Basemap_JA2000_ v

I Note:

The current layer starts as DA2023. The replacement layer is DA2024. You are archiving the DA2023 hosted tile
layer, and the current layer (Esri_Vector_Basemap_v2) now displays the DA2024 hosted tile layer. Replacing the
tile set allows the item ID and URL paths to remain intact, so maps and apps continue to work with the current
layer and display the new DA2024 basemap content.

The Success message flashes briefly at the top of the screen.

8. To verify a successful replacement, in My Content, go to the item page for the Esri_Vector_Basemap_v2 vector
tile service.
Your item will look like the following:

| @esri |
| BATA AFPLIANCE 202 |
, W ri

el _Vector_Bavemap D034 _imsall. Tris vactor ¢
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I Note:
The thumbnail is not replaced, but the summary is Esri Vector Basemap for Data Appliance 2024 and the details
indicate it was created from the Esri_Vector_Basemap_DA2024_Install Vector Tile Package.

Update existing tile layers (map styles)

Use the Vector Style Updater tool to update your existing layers.

1. Open the DA2024_WMA_StyleUpdater_template.csv file located in the C:\Projects\
Esri_Vector_Basemaps_2024\Toolbox folder.

a.

Include the item IDs of all your existing styles in the itemid column in this table. Obtain the item ID for each

style from the portal URL for each style. Only copy and paste the series of letters and numbers after . ..id=.
RN oy P e - RS E]

lome Gallery Map Seane Groups Content Organization

World Topographic Map (Local Language) #

b. Once you fill in the itemid column, save the file and rename it DA2024_WMA_StyleUpdater.csv.

File Home Insert Page Layout Formulas Data Review WView Help 2 search 2 Share

AlG
A B G

1 |itemnid title foldemame
2 |ee2753804caTdT55ac9a11381508a271  Charted Territory chartedterritory
3 |cTd4654088284ecefBoa5ed545961859  Colored Pencil coloredpencil
4 | cfa007T5be5b9496385899cdaf3a5125d Community community

L Note:

These are example item IDs. Use the IDs that are unique to your items in your portal.

2. Run the Vector Style Updater tool.

a.

Start ArcGIS Pro, sign in to your ArcGIS Enterprise portal, click the Options button ==+, and click Set As Active
Portal.

. Create a project.
. Click the View tab, click Catalog View in the Windows group, right-click Toolboxes, and click Add Toolbox.

. Browse to the location on your local computer where you copied the contents of the USB flash drive, click

VectorStyleUpdater.tbx, and click OK.
The VectorStyleUpdater toolbox is added to the project.

Double-click Toolboxes, and double-click VectorStyleUpdater.tbx.
Double-click the Vector Style Updater script.

-IL{-} -I:’Bl D » Project » Toolboxes » VectorStyleUpdater.thx

— Vector Style Updater

E[ Serit

. On the Vector Style Updater dialog box, click the Parameters tab and do the following:

Copyright © 1995-2024 Esri. All rights reserved. 42



ArcGIS Data Appliance: Esri Vector Basemaps

Geoprocessing wi B

S

& Vector Style Updater & v}
Parameters Enwvironments
tad Tl containing the itesn name and id
ADA2024 _WMA _StyleUpdate

Folder containing vector styles

orBasemapStyles\WMA_Styles\WMA_ExistingUser\WMA_UpdatedStyles

Vector Tile Service URL
{poﬁal name:> fservices/Hosted/Esri_Vector_Basemap_v2/NVectorTileServer

Metadata folder name
metadata

Share vector style web layers publicly

i. For CSV formatted file containing the item name and ids (.csv), browse to the location of the
DA2024_WMA_StyleUpdater.csv file on your local computer.

ii. For Folder containing vector styles, browse to the location of the WMA Updated Styles folder on your
local computer, for example, C:\Projects\Esri_Vector_Basemaps_2024\VectorBasemapStyles\

WMA_Styles\WMA ExistingUser\WMA_UpdatedStyles.

iii. For Vector Tile Service URL, provide the URL of the Esri Vector Basemap tile layer that you replaced
above, for example, https://portalname.domain.com/server/rest/services/Hosted/

Esri_Vector_Basemap_v2/VectorTileServer.

I Note:
The vector tile service URL is in the URL section of the Esri_Vector_Basemap_v2 hosted tile layer item
page. Click the Copy button and paste the URL in the Vector Tile Service URL parameter text box.

Esri_Vector Basemap_v2

Ohpor in Map Viewsr

s

= v
g esrn
DATA APPLIANCE #0335
WMA
. Y
Des io

Sources: Lsn, TomTom, Garmin, FAQ,

iv. For Metadata folder name, keep the default name metadata.
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I Note:
If you are using a portal with PKI authentication, expand PKI Authorization and provide values for the
PKI_Certificated_file_(.pfx) and PKI Private Password parameters.

v PKI Authorization
PKI_Certificated_file_(.pfx)

PKI Private Password

If you are using a portal with Linux LDAP authentication, expand Linux LDAP and provide values for the

Sign In Username and Sign In Password parameters.

¥ Linux LDAP

Sign In Username

Sign In Password

3. Click Run.
It can take up to a minute to update each existing style in your portal using the Vector Style Updater tool.

The VectorStyleUpdater toolbox displays a successful update message when complete.

All of the existing 51 vector tile layers (map styles) are updated in your assigned ArcGIS Enterprise account.

Publish new tile layers (map styles)

Now that you've published and updated your hosted vector Tile Layer and updated the existing styles, you are
ready to publish the new map styles.

VectorStylePublisher.tbx is a geoprocessing toolbox that is run in ArcGIS Pro. This toolbox publishes new

private map items in your portal for one new vector tile layer and transfers the vector basemap style resource
folders and files and metadata for the map item pages from your local computer to your portal.

1. In the ArcGIS Pro project you created to update the existing styles, select the View tab, select Catalog View in
the Windows group, right-click Toolboxes, and select Add Toolbox.
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Catalag Insert Analysis Wiew Imagery Share

@ ; E E E‘ [/] Show Details Panel Display Type ~

Search My Organization_| More Detail
Reset Catalog Catalog Contents Python Tasks Reviewer Workflow - My Org o '
Panes~ Pane  View Rules  Manager= [/] Show Pop-ups

Windows Options

C’f} —l » Project »

Maps
Toolboxes |
73 Add Toolbox b |
K New Toolbox Add Toolbax
B New Bython Toolbox | Add an existing toolbox to the project. The project
Databases saves a reference to the toolbox.
=

2. Browse to the location on your local computer where you copied the contents of the USB flash drive, select
VectorStylePublisher.tbx, and select OK.

Add Toolbox x
) = [ ) - e S
& 1-“} [E]« 0sDisk(C) » Projects » Esri Vector Basemaps_2024 » Toolbox » =+ [0 Search
Organize ™ New ltem ~
'Y
4 [ Esri_Vector Basemaps_2024 Name Type
" | Toolbox B3 VectorStylePublishertbx I Toolbex
I VectorBasemapStyles Bl VectorStyleUpdater.thy Toolbax
VTPK
v
4 5 - »
Mame l»‘ec'.o-‘i:f.epub‘ushh.w ]. Toalbooes (Al Types)
[=

The VectorStylePublisher toolbox is added to the project.

3. Double-click Toolboxes, and double-click VectorStylePublisher.tbx.
@ @“:‘ » Project » Toolboxes »

MyProject.thx

_ VectorStylePublisher.tbx
Toolbon

10/25/2018 1138 AM

4. Double-click the Vector Style Publisher script.
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== Catalog X

(_-jl ’!‘,' |:| » Project » Toolboxes » VectorStylePublis

Vector Style Publisher

5. On the Vector Style Publisher dialog box, select the Parameters tab and provide the following:
a. For Folder containing vector styles, browse to the location of the WMA New Styles folder on your local
computer, for example, C:\Projects\Esri_Vector_Basemaps_2024\VectorBasemapStyles\WMA\

WMA_ExistingUser\WMA_NewStyles.

b. For Vector Tile Service URL, provide the URL of the Esri Vector Basemap tile layer, for example,
https://portalname.domain.com/arcgis/rest/services/Hosted/Esri_Vector_Basemap_v2/

VectorTileServer.

I Note:
The vector tile service URL is in the URL section of the Esri_Vector_Basemap_v2 hosted tile layer item page.
Click the Copy button and paste the URL in the Vector Tile Service URL parameter text box.

c. For Metadata folder name, keep the default name metadata.

L Note:
If you are using a portal with PKI authentication, expand PKI Authorization and provide values for the
PKI_Certificated_file_(.pfx) and PKI Private Password parameters.

v PKI Authorization

PEI_Certificated_file_{.pfx)

PKl Private Password

If you are using a portal with Linux LDAP authentication, expand Linux LDAP and provide values for the
Sign In Username and Sign In Password parameters.

v Linux LDAP

Sign In Username

Sign In Password

d. Click Run.

With the addition of the new map styles, you can view all 55 tile layer items in My Content.
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Share tile layers (map styles)

The items initially created are private unless you made them public through the Publisher toolbox dialog box or by
selecting the map items in your portal and changing the sharing settings.

Share
Share the itern(s) with:

Everyone

Authentication

These settings will replace the current semtings.

Mo groups available to share to.

OK _arce

Once you set up the Esri Vector Basemaps update, you can do the following:
* Use Esri Vector Basemaps
 Customize styles

* Localize styles
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Troubleshoot Esri Vector Basemaps

Listed below are issues you may encounter when working with Esri Vector Basemaps content for ArcGIS Data
Appliance 2024 as well as recommended solutions.

« What if the size of the uploaded .vtpk file does not match the size of the source .vtpk file?

« When running the Share Package tool to share the .vtpk file from Esri Vector Basemaps, | encountered the
Cancelled function, aborted by user error message.

» What if | encounter the There was an error message when | try to publish the service?

» What do | do if the progress bars keep loading when I'm trying to publish my service?
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What if the size of the uploaded .vtpk file does not match the size of the source .vtpk file?

If your tile layer (hosted) service did not publish successfully, an issue may have occurred during the upload of the
vector tile package (.vtpk) to your portal. The size of the . vtpk file on disk and the size of the uploaded file on
your portal must match.

Confirm that the Size value of the tile package matches the size of the vector tile package and Enterprise version in
the following table:

Vector tile package . vtpk file Enterprise version Size
10.9.1 44,616 MB
Esri_Vector_Basemap_DA2024 Install.vtpk (WMA) 11.0 46,784 MB
11.1and 11.2 44,616.449 MB
10.9.1 44,286 MB
Esri_Vector Basemap_ GCS DA2024 Install.vtpk (WGS84) @ 11.0 46,438 MB
11.1and 11.2 44,286.461 MB

You can check the size of the uploaded vector tile package (supporting the service) on the item details page. The
following screenshot shows the Esri_Vector_Basemap_GCS_DA2024_Install vector tile package details in Enterprise
11.2.

Details

Size: 44,286.461 MB

Share
m

If the size does not match, check the log through the server manager to see whether there are any errors.

In some cases, the ArcGIS Pro Share Package geoprocessing tool may have produced a Success message, but when
you check the size of the .vtpk file on the item details page, it does not match. Here are some solutions that you

can try to resolve this issue:

« Upload the .vtpk file again. First, delete the Esri_Vector_Basemap_DA2024_Install.vtpk or
Esri_Vector_Basemap_GCS_DA2024_Install.vtpk file from your portal. Next, upload the
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Esri_Vector_Basemap_DA2024 Install.vtpk or Esri_Vector_Basemap_GCS_DA2024_Install.vtpk file
again using the ArcGIS Pro Share Package geoprocessing tool.

« Verify with your portal administrator that there is the following minimum available space per .vtpk file on your
Enterprise 10.9.1, 11.0, 11.1, or 11.2 portal:

Minimum c . . .
total !-I%s:’l.ng server's Ho.;.tmg server's
Vector tile package (.vtpk) file available Jo il lrbtictory cac.lebllrectory
space available space available space
. required required

required

Esri_Vector_Basemap_DA2024 Install.vtpk

(WMA) 94 GB 47 GB 47 GB

Esri_Vector_Basemap_GCS_DA2024 Install.vtpk

(WGS84) 94 GB 47 GB 47 GB

Ensure that there is space on <ArcGIS portal install drive>\arcgis\arcgisportal where the content
items are stored.

- Verify that you are using a supported version of ArcGIS Pro. See the system requirements for details.

Contact Esri Support if you still cannot successfully upload the .vtpk file.

I Note:

The following answers reflect troubleshooting of the WMA vector tile package and service. To troubleshoot the GCS

vector tile package and service, you need to take the GCS naming into consideration.

When running the Share Package tool to share the .vtpk file from Esri Vector Basemaps, | encountered the

Cancelled function, aborted by user error message.

When you publish the . vtpk file, it creates a copy of the file at \\arcgisportal\temp in the C: drive, which is the

staging path. There is not enough space on the C: drive for the staging process, so the publishing attempt failed.

Ensure your local computer has enough storage space to download the files from the flash drive. The additional
storage space required for the local staging path is equal to the size of the .vtpk file being shared to your portal.
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What if | encounter the There was an error message when I try to publish the service?
Work with your system administrator to check the ArcGIS Server Manager logs.

If there is an error due to a geoprocessing service (PublishingTools) timing out or crashing, you may have skipped a
system requirements step. Confirm that you changed the value of The maximum time a client can use a service
to 21,600 seconds.

Once you have updated the geoprocessing service maximum time, do the following:

1. On your server, delete the Esri_Vector_Basemap_v2 or Esri_Vector_Basemap_GCS_v2 hosted tile layer.

2. On the ArcGIS Server machine, delete the job in the <ArcGIS_Server_Install_Path>\arcgis\

arcgisserver\directories\arcgisjobs\system\publishingtools gpserver\<Job_ID> folder.

I Note:
You can find the job ID in the log file.

3. Restart the server.

4. Verify you have the following minimum available space per .vtpk file on your ArcGIS Server:

Minimum total available space required

Vasiar il el e (i) (e (Enterprise 10.9.1, 11.0, 11.1, 11.2)

Esri_Vector_Basemap_DA2024 Install.vtpk

(WMA) 94 GB
Esri_Vector_Basemap_GCS_DA2024 Install.vtpk 94 GB
(WGS84)

5. In your portal, publish the Esri_Vector_Basemap_v2 or Esri_Vector_Basemap_GCS_v2 tile layer again.
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What do | do if the progress bars keep loading when I'm trying to publish my service?

Overview

# Edit Thumbnail

Creating Service

* Add to Favorites

If the Creating Service progress bar continues to load after two hours, the browser connection to the portal may
have failed.

Sign out of the portal and sign in again to see if the thumbnail has changed to the Data Appliance 2024 icon,
because the browser connection does not affect the creation of the service.

Esri_Vector_Basemap_DA2024_v2

/ Edit thumbnail
. Esri Vector Baser
= 28 Vector Tile Pac
h @esri _ Created:

DATA APPLIANCE 2024
WMA

¢ Add to Favorites

If the thumbnail changes to the Data Appliance 2024 icon, verify that the map displays as expected.
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Additional resources

The following resources are available for Esri Vector Basemaps:

ArcGIS Data Appliance 2024: Esri Vector Basemaps help [PDF]

ArcGIS Data Appliance 2024: Esri Vector Basemaps New user information video [captioned MP4] demonstrating
uploading, updating, and publishing Esri Vector Basemaps to your portal

ArcGIS Data Appliance 2024: Esri Vector Basemaps Existing user information video [captioned MP4]
demonstrating uploading, updating, and publishing Esri Vector Basemaps to your portal

ArcGIS Data Appliance 2024: Esri Vector Basemaps Reference Document (v2) [PDF]
Tile layers, Customize basemaps, and Choose a basemap (Map Viewer Classic) in the Portal for ArcGIS help
New ways of customizing Esri Vector Basemaps blog article

Create a custom basemap style using the ArcGIS Vector Tile Style Editor on the ArcGIS Developer website
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Use
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Use Esri Vector Basemaps

With the addition of vector tile packages (. vtpk), hosted tile layers, and tile layers in your portal, a number of items
appear in your ArcGIS Enterprise Content window. With the correct administrative privileges, you can create folders,
groups, and categories. By creating folders and moving items into them, you can organize your Content window to
make it easier to find the items you are looking for. The following image shows some folder name suggestions. See
Manage content in the Portal for ArcGIS help for information about managing content in ArcGIS Enterprise.

Home Ga ery Map Scene Groups Content {:}'-\3{: nization

Content My Content My Fav

Folders = 1-20 of 57 in All My Content

B World Terrain Reference (Local Lang. age Tile Laye
= L7 A TEE & e % Modern A = Tile Laye
B DAZ024-VTPK and Hasted i

Tile Layers
@ man Geography Dark Deta Tile Laye

You can use Esri Vector Basemaps in your applications in the following ways:

« Add the 55 map tile layers (styles) to a map in ArcGIS Pro or to Map Viewer Classic in your Enterprise portal.
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World Terrain with Labels (Community
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Upceatea
Fan
@
-3 World Street Map (with Relief -
Community Maps
@ by
Updated
@
Map (Night - Community
Upceatea
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|\—i—/|
World Street Map (Community Maps
z L

+ Add the tile layers (styles) to an existing basemap, or add them as the basemap.
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Add to Map

* You can use 17 of the 55 map tile layers (styles) with a raster layer—World Hillshade, World Imagery, or World
Ocean Base—as the basemap in a web map.
* Charted Territory—World Hillshade

= Modern Antique—World Hillshade

= National Geographic Style—World Hillshade

= National Geographic Style (Local Language)—World Hillshade
= World Street Map (with relief)—World Hillshade

= World Street Map (with relief - Community Maps)—World Hillshade
= World Terrain Base—World Hillshade

= World Terrain Reference—World Hillshade

= World Terrain Reference (Local Language)—World Hillshade

= World Terrain with Labels—World Hillshade

= World Terrain with Labels (Community Maps)—World Hillshade
= World Topographic Map—World Hillshade

* World Topographic Map (Local Language)—World Hillshade

= Hybrid Reference Layer—World Imagery
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= Hybrid Reference Layer (Community Maps)—World Imagery
= Hybrid Reference Layer (Local Language)—World Imagery
= World Ocean Reference—World Ocean Base

« If you have a tile layer (style) in your map, you can move it to the basemap.

oma v My Map

* Add -

[Z] Details

Contents

» Move the Dark Gray or Light Gray Canvas Reference layers to the basemap and set them as the reference layer
over the Canvas Base layer. You can also do this with the World Terrain Base and Reference, Hybrid Reference,
Human Geography Labels, and Human Geography Dark Labels tile layers.

v My M

Contents
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Customize styles

With ArcGIS Data Appliance: Esri Vector Basemaps, you can modify and customize the map style. You can customize
the map by changing the hex color codes of map features or labels, removing feature classes, changing fonts (face,
size, and color), or making other edits. For more information, see the vector basemap blog post on the ArcGIS Blog
website.

Customization requires changes to the map style's resources\styles\root. json file. There are two main ways to
customize your maps: add a style to the map in Map Viewer Classic or copy a root. json style from the USB flash

drive. In ArcGIS Enterprise, you can use the ArcGIS Vector Tile Style Editor. Then you can edit the custom style map
item to include a new thumbnail and update the item's information for your custom style.

Add a style to the map in Map Viewer Classic and rename the style
To add a style using Map Viewer Classic, complete the following steps:

1. In your Enterprise portal, open the style you want to customize in Map Viewer Classic, for example, Dark Gray
Canvas Base.

2. Click More Options ---, and select Copy.

me » T'.f'l"-,-' M ap

tail * Ad Basem
About Content Legend
Contents
# Dark Gray Canvas Base
¥ 3 Loom to
Transparency
£% Set Visibility Range
Rename
Remove

| Copy
3 Move to Basemap

1 Show Item Details

A new Dark Gray Canvas Base - Copy layer is added to the top of the Contents pane.

3. Click More Options ---, and select Save Layer.
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Home w» M\j MJ[Z?
| B petsits | #% ade ~ | BEB:
\ |
@ sbout [I] Content I Lec
Contents
# Dark Gray Canvas Base - Copy
@ p & Zoom to

"1 Transparency

f 2% Set Visibility Range

W Move down
Rename
x Remove

Copy
Move to Basemap

| Description

gm | B @2

Save Laver

4. Rename the style, for example, Custom Canvas Base, and select the portal folder where you want to save the
new style.

5. In My Content, go to the item page for the new style, and click the Download style button.
Custom Canvas Base e

A Edit =
OpaninM... w
This vector tile layer provides a detailed # Ed
biase st fark neutral _ £

e i Last Modified m

The style (root. json file) is saved to your computer.

6. Open the root. json file in a text editor such as Adobe Brackets or Notepad++, and edit and save the file.
Edits to the root. json file can be color value, line width, font size, and so on.

7. Validate the JSON using JSONLint or a similar JSON validation tool. You can also use this website to parse the
JSON into a more user-friendly format before editing.

8. On the item page for the new style, click the Update button to update the item and load the modified
root. json file from your computer to your portal.

Copy a style from the USB flash drive and rename the map style directory

To copy a root.json style from the USB flash drive, complete the following steps:

1. On your local computer, create a directory called CustomStyles at the same directory level as the GCS and
WMA directories.
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» Projects » Esri_Vector_Basemaps_2024 » VectorBasemapStyles

o

Name Type
Custom5tyles File folder
GCS_styles File folder
WA _styles File folder

2. Copy a style from the USB flash drive and rename the map style directory; for example, copy the canvasdarkbase
directory into a new directory and change the name to customcanvasbase.
Lo v 4 o 0506k (C:) » Projects » Esri Vector Bazernaps 2024 » VectorBasemmapStyles » CustomStyles » custormcanvasbase »

Name Type

Esri_Vector_Basemaps_2024

oo metadata File
VectorBasernapStyles rasunee: File falder
CustamStyles

customcanvasbase

GCS_styles

WA styles
VTRK

3. In the new customcanvasbase directory, open the resources\styles\root. json file (for example,
CustomStyles\customcanvasbase\resources\styles\root.json ) in a text editor such as Adobe Brackets
or Notepad++, edit the map code, and save the file.

An example of a style edit in the root. json file is changing the highways in dark gray (#2A2B2B) to red

(#FF0000).

Yl e

"id": "Road/Highway/1", "id": "Road/Highway/1",

"types": "lins", "type™: "lina™,

Fesource®: "espi®, *sourea®: Fesri®,

"source-layer”: "Road", "source—layer™: "Road”,

"filear": ["all", ["=", " aymbal", 1], "Filear®: ["all®, ["=", " symbol", 1],
[Flant.-Tyiz®. 3] [*1in®, "wiz®, 3]

1. 1.

"minzoom®™: 8, "minzoom™: B,

"layout™: | "layout™: |
"line-join®: "round” "line-join": "round"

Fe 3

"paint": | "paint™: |

nlinc—cclo "line-colozr
"line-wideh": "line—width":

"bazse: 1.2, “baze™: 1.2,

"atops™: | "atopa®: [
(8, 0.3], (8, 0.31,
[14, B8.3], [14, B8.3].

4. In the new customcanvasbase directory, open the metadata\metadata.json file (for example, CustomStyles\
customcanvasbase\metadata\metadata.json) in a text editor such as Adobe Brackets or Notepad++; edit
"title":, replacing "Dark Gray Canvas Base" with a new map title, for example, "Custom Dark Base"; and

then save the file.
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[=] metadata json E3

"owner": "esri",
5 "orgId": " ",
"created": 1479914141000,
"modified": 1501816841000,
B "guid": null,
9 "name": null,
10 "title": "Dark Gray Canvas Base",
11 "type": "Vector Tile Service",
12 "typeKeywords": ["Data", "Service", "Vector
Service"],
13 "description™: "<div style='font-family:
&guot;Avenir Next WOlagquot;, &guot;Avenir Ne

WANT st - fenimt = Raranma v Moawd fenad - Nrrama w

5. Validate the JSON using JSONLint or a similar JSON validation tool.

6. Perform the Publish tile layers (map styles) steps, this time pointing to the new directory containing your custom
style.

The new style is created in your Enterprise portal under My Content. Following the naming conventions in steps
1-4 produces a new item in your portal named Custom Canvas Base.

Edit the custom style map item in your portal

On the map item page of your custom map style, you can update the summary, description, tags, and thumbnail to
better describe the new map you styled.

It is recommended that you apply Delete Protection to your custom style map item on the item's Settings tab.

Heme Gallery Map Seene Groups Content Organization

Custom Dark Base /e

Usage Settings

Description

his vector tile layer is a customized version of the Dark Gray Canvas Base.

The transportation network has been changed to red roads to provide better visiblity of the roads across the map.

Esri Vector Tile Style Editor

You can customize vector map styles through an app in the Map Viewer Classic. Access the Style Editor from the
Change Style button under any Esri vector basemap tile layer. Save the new style to your portal.
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[E] Details  # Add ~ | BB Basemap

About  [E] Content = Legend
Contents

: ¥ Light Gray Canvas

’ ‘“ Change Style

Styling options include the Quick Edit tool, in which layers are customized across groups of features, and the Layer
Style Editor list for individual feature style controls. Colors, line weights, font faces, and sprite symbology are
examples of the style changes that can be applied to your custom map item.

Change Style

7o W @ @

1
_. A >
» e = 54)
*-_ h

[ sew e e |
Information about using the ArcGIS Vector Tile Style Editor to Create a custom basemap style is available on the
ArcGIS Developer website.
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Localize Esri Vector Basemap styles

ArcGIS Data Appliance: Esri Vector Basemaps supports localizing select map labels into the languages listed below.
The default map displays a primarily English global view. Localization is another form of basemap customization. As
with other customization, there are two main ways to create a style for customization: add a style to the map in
Map Viewer Classic or copy a root. json style from the USB flash drive. Review the information in the previous

section on how to Customize Esri Vector Basemap styles.

Localization changes the labels on the map for many of the small-scale features when the data supports it. Localize
the map by changing the "text-field" value of the map style's resources\styles\root. json file. Use the

corresponding codes for the language you want to display. It is also recommended that you change all "text-
font" to an Arial Unicode font (“Arial Unicode MS Regular” or “Arial Unicode MS Bold") to allow all glyphs to

display on the map. After the localization changes are applied to your JSON, validate the JSON using JSONLint or a
similar tool, and update or upload the new localized map style as previously detailed in this help document. The
edits can also be applied on the JSON through the Vector Tile Style Editor.

Languages and codes supported in Data Appliance 2024
The following language codes are supported in Data Appliance 2024:

Language Code
Arabic ar
Bosnian bs
Bulgarian bg
Catalan ca

Chinese (Hong Kong) @ zh_h
Chinese (Simplified) zh_s

Chinese (Taiwan) zh_t
Croatian hr
Czech cs
Danish da
Dutch nl
English en
Estonian et
Finnish fi
French fr
German de
Greek el
Hebrew he
Hungarian hu
Indonesian id
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Language Code
Italian it
Japanese ja
Korean ko
Latvian lv
Lithuanian It
Norwegian no
Polish pl
Portuguese (Brazil) pt_b

Portuguese (Portugal) | pt_p

Romanian ro
Russian ru
Serbian sr
Slovak sk
Slovenian sl
Spanish es
Swedish sv
Thai th
Turkish tr
Ukrainian uk
Vietnamese vi

Features supported for localization

The following features can have their "text-field" values changed to support these languages. The map labels

that can be localized are primarily features displayed at small scale. At large scale, the default JSON labels the map
in English "{_name_global}" or you can change it to the local language "{_name_local}" in each country where

the map data supports it. Apply the small scale feature changes first, before any changes to large scale features.
Using a text editor, find each "id" name and change its "text-field" value accordingly.

Small scale features

The default JSON for these features is "text-field": "{_name_global}". Listed below are the 88 "id" fields in
the worldtopomap style JSON available for localization when the data supports it at primarily small scales. Other
styles may have all or fewer of these features.

For example, to display the map in Chinese (Simplified), the JSON for each of these features changes "text-
field": "{ name_global}" to "text-field": "{ name_zh_s}", for French, "text-field": "{_name_fr}",
and so on.
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Water point/Sea or
ocean

Water point/Island

Water point/Dam or
weir

Water point/Playa
Water point/Canal or
ditch

Water point/Stream or
river

Water point/Lake or
reservoir

Water point/Bay or
inlet

Water line/label/
Default

Water line large scale/
label/Default

Water line medium
scale/label/Default

Water line small scale/
label/Default

Water area/label/Dam
or weir
Water area/label/Playa
Water area/label/Canal
or ditch

Water area/label/Small
river

Water area/label/Large
river

Water area/label/Small
lake or reservoir

Water area/label/Large
lake or reservoir

Water area/label/Bay
orinlet

Water area/label/Small
island

Water area large scale/label/
River

Water area large scale/label/
Lake or lake intermittent

Water area medium scale/label/

Default

Water area small scale/label/
Default

Marine waterbody/label/small

Marine waterbody/label/
medium

Marine waterbody/label/large

Marine waterbody/label/x large

Marine waterbody/label/2x
large

Indigenous/label/Default

Military/label/Default

Admin1 forest or park/label/
Default

AdminO forest or park/label/
Default

Admin1 area/label/x small
Admin1 area/label/small
Admin1 area/label/medium
Admin1 area/label/large
Admin1 area/label/x large
Admin1 area/label/2x large
City large scale/town small

City large scale/town large
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City large scale/medium

City large scale/large

City large scale/x large

City small scale/town
small non capital

City small scale/town
large non capital

City small scale/small
non capital

City small scale/medium
non capital

City small scale/other
capital

City small scale/town
large other capital

City small scale/small
other capital

City small scale/medium
other capital

Admin0 point/x small
Admin0 point/small
Admin0 point/medium
Admin0 point/large

Admin0 point/x large
City small scale/town
small admin0 capital

City small scale/town
large adminO capital

City small scale/small
admin0 capital

City small scale/medium
admin0 capital

City small scale/large
other capital

City small scale/large
non capital

City small scale/large
adminO capital

City small scale/x large
non capital

City small scale/x large
admin1 capital

City small scale/x large
adminO capital

AdminO0 point/2x large

Continent

Disputed label point/
Island

Disputed label point/
Waterbody

Landform/label/Round
small

Landform/label/Round
medium

Landform/label/Round
large

Landform/label/Round
x large

Landform/label/Round
small

Landform/label/Round
small point

Landform/label/Round
medium

Landform/label/
Oblong medium point

Landform/label/
Oblong large

Landform/label/
Oblong large point

Landform/label/
Oblong x large

Landform/label/
Oblong x large point
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Water area/label/Large
island

Large scale features

City large scale/small

City small scale/x large
admin2 capital

Disputed label point/
Admin0

Apply JSON changes to the small scale features first. For large scale features, the default JSON is "text-field":

"{_name_global}" and displays labels in English. If you are changing the map to the local language in each

country where the data supports it, the JSON for these features changes to "text-field": "{_name_local}".
Find and replace "{_name_global}" with "{_name_local}" throughout the JSON file. Listed below are the 47
"id" fields in the streetmap style JSON available for local language in each country where the data supports it.

Other styles may have all or fewer of these features.

For example, "text-field":

Ferry/label/Ferry
Marine park/label/Default

Marine area/label/Default

Ferry/label/Rail ferry

Railroad/label/Default

Trail or path/label/Default

Road tunnel/label/
Pedestrian

Road tunnel/label/Local

Road tunnel/label/Minor

Road tunnel/label/Major

Road tunnel/label/Highway

Road tunnel/label/Freeway
Motorway

Other features

There are other features on the map with "text-field"

"{ name_global}" becomes "text-field": "{ _name_local}".

Pedestrian/label/Default
Road/label/Pedestrian

Road/label/Local

Road /label/Minor

Road/label/Major

Road/label/Highway

Road/label/Freeway
Motorway

Cemetery/label/Default

Freight/label/Default

Water and wastewater/
label/Default

Port/label/Default

Industry/label/Default

support localization; do not change their JSON code.

Changing the font

Government/label/
Default

Finance/label/Default
Emergency/label/Default

Transportation/label/
Default

Beach/label/Default

Golf course/label/Default
Zoo/label/Default
Retail/label/Default

Landmark/label/Default

Openspace or forest/
label/Default

Park or farming/label/
Default

Point of interest/Park

Education/label/
Default

Medical/label/Default
Airport/label/Airport
property

Exit/Default

Point of interest/Bus
station

Point of interest/Rail
station

Point of interest/
General

Admin2 area/label/
small

Admin2 area/label/
large

Neighborhood

Building/label/Default

: "{_name}" in the JSON file. These features do not

It is recommended that you change the fonts to Arial Unicode (bold or regular). Esri Vector Basemap styles can have
different default fonts. For example, the default fonts for streetmap style are Arial Bold, Arial Italic, and Arial Regular.
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For the worldtopomap style, the default fonts are Noto Sans Bold, Noto Sans Italic, Noto Serif Regular, and Roboto
Condensed Light Italic. Refer to the font list in the ArcGIS Data Appliance: Esri Vector Basemap Reference Document
(v2) PDF in the Additional resources topic for complete details. Change the fonts to "text-font" : ["Arial
Unicode MS Regular"]. Fonts that are bold by default can be changed to "text-font" : ["Arial Unicode MS
Bold"]. There is no italic font in the Arial Unicode family.
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An example of the streetmap style is shown in Chinese (Simplified).

An example of the navigation style is shown in Spanish.

Additional JSON edits for Arabic language maps

To ensure that Arabic glyphs appear correctly on the map, either set the text-spacing setting to 0 (zero) or
completely remove the "text-letter-spacing" style attribute from the root.json file. JSON styles may display
this attribute as follows:

"text-letter-spacing” : 0.05,
Or the style may have more complex syntax such as the following:
"text-letter-spacing" : { "stops" : [[4, ©.1], [8, ©.18]] }

Either change these to "text-letter-spacing" : @, or remove the lines completely. Be sure to validate any
root. json before updating the file on your portal.
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Terms of use for ArcGIS Data Appliance: Esri Vector
Basemaps

ArcGIS Data Appliance: Esri Vector Basemaps should only be served up from ArcGIS Server and Portal for ArcGIS
(10.9.1, 11.0, 11.1, or 11.2). ArcGIS Data Appliance: Esri Vector Basemaps cannot be transferred to or used with
non-Esri technology.

For more information, see the Master Agreement, Products and Services on the Esri website.
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Copyright Information

Copyright © 1995-2023 Esri. All rights reserved. Published in the United States of America.
The information contained in this document is subject to change without notice.

You may have received Products or Services that include Graph Editor Toolkit, Copyright © 1992-1999 Tom Sawyer
Software, Berkeley, California, All Rights Reserved, and Tom Sawyer Visualization, Ver. 8.0 Copyright © 1992-2009
Tom Sawyer Software, Berkeley, California, All Rights Reserved.

Portions of this computer program are Copyright © 1995-2016 Celartem, Inc., dba Extensis. All rights reserved.

This application supports the ECW data format and ECWP compression protocols. Portions of this computer
program are Copyright © 2007-2015 Intergraph Corporation. All rights reserved. Creating compressed files using
ECW technology is protected by one or more of U.S. Patent No. 6,201,897, No. 6,442,298, and No. 6,633,688.

PANTONE® Colors displayed in the software application or in the user documentation may not match PANTONE-
identified standards. Consult current PANTONE Color Publications for accurate color. PANTONE® and other
Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2020. Pantone is the copyright owner of color
data and/or software which are licensed to Esri to distribute for use only in combination with the ArcGIS family of
Products. PANTONE Color Data and/or Software shall not be copied onto another disk or into memory unless as
part of the execution of the ArcGIS family of Products.

This product includes software developed by the JDOM Project (http://www.jdom.org/).

This product includes software developed by the Indiana University Extreme! Lab (https://web.archive.org/web/
20210225153105/https://www.extreme.indiana.eduy/).

The ArcGIS platform consists of many programs and services—some of which may have been developed using
Altova® XMLSpy® and includes libraries owned by Altova GmbH, Copyright © 2007-2023 Altova GmbH
(www.altova.com).

Third-Party OSS-FOSS Acknowledgement Documents

Esri's use of open source software libraries is disclosed in the Third-Party OSS-FOSS Acknowledgement Documents
found at the link below.

Open Source Acknowledgements (https://links.esri.com/open-source-acknowledgments)

ArcGIS Notebooks makes use of The FreeType Project, following The FreeType Project License
(https://git.savannah.gnu.org/cgit/freetype/freetype2.git/tree/docs/FTL.TXT).

EXPORT NOTICE

Use of these Materials is subject to U.S. export control laws and regulations, including the U.S. Department of
Commerce Export Administration Regulations (EAR). Diversion of these Materials contrary to U.S. law is prohibited.

US GOVERNMENT CUSTOMER

The Products are commercial items, developed at private expense, provided to Customer under this Master
Agreement. If Customer is a US government entity or US government contractor, Esri licenses or provides
subscriptions to Customer in accordance with this Master Agreement under FAR Subparts 12.211/12.212 or DFARS
Subpart 227.7202. Esri Data and Online Services are licensed or subscribed under the same DFARS Subpart
227.7202 policy as commercial computer software for acquisitions made under DFARS. Products are subject to
restrictions, and this Master Agreement strictly governs Customer's use, modification, performance, reproduction,
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release, display, or disclosure of Products. Agreement provisions that are inconsistent with federal law regulation
will not apply. A US government Customer may transfer Software to any of its facilities to which it transfers the
computer(s) on which it has installed such Software. If any court, arbitrator, or board holds that a US government
Customer has greater rights to any portion of the Products under applicable public procurement law, such rights
will extend only to the portions affected. Online Services are FedRAMP Tailored-Low authorized but do not meet
higher security requirements, including those found in DFARS 252.239-7010.

Esri Trademarks

Esri Products or Services referenced in this work are trademarks, service marks, or registered marks of Esri in the
United States, the European Community, or certain other jurisdictions. To learn more about Esri marks, go to the Esri
Product Naming Guide (https://links.esri.com/product-naming-guide).

Licensed Trademarks

Other companies and products or services mentioned herein may be trademarks, service marks, or registered marks
of their respective mark owners.

The Kubernetes ship's wheel logo is a registered trademark of the Linux Foundation.

Trademark Images

Logos of licensed trademarks include the following:

OGC

Making location count.

PANTONE'
Digital Color
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Support for ArcGIS Data Appliance 2024: Esri Vector
Basemaps

Support for ArcGIS Data Appliance: Esri Vector Basemaps is provided by the Esri Support team.

Use the following contact options:

« United States users—Contact Esri Support using one of the following options. Hours are Monday through Friday,
5:00 a.m. to 5:00 p.m. (Pacific time), excluding Esri holidays:
= Phone—888-377-4575

= Web page—https://support.esri.com/en-us/contact

« International users—Support is provided by your local Esri distributor.
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